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Axon Conventional Electrophysiology Family 

• pCLAMP software 

• Clampex-data acquisition 

• Clampfit-Data analysis 

• Axoscope-Data continuous 
monitoring 

• Digitizer 

• Digidata 1440A-Analog-to-Digital 
converter 

• Patch-clamp amplifiers 

• Axopatch 200B 

• MultiClamp 700B 

• AxoClamp 900A 
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Flow of recording signal 

MultiClamp 700B Axoclamp 900A 

Axopatch 200B 

Biological signals: 

current and voltage 

Digidata 1440A 

Digital 

Conversion 

pCLAMP 10 

Software 

Amplifiers 

Digitizer 

Software 
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Electrophysiology rig 
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Measurement Techniques 
• Extracellular voltage recording 

• Single unit and field potential recording in brain or brain 
slices, electrocardiagrams, encephalograms and 
oculograms 

• Voltage clamp 

• Voltage is held constant and the current passing through 
the cell membrane is measured 

• Patch-clamp recording 

• Two electrode voltage clamp 

• Voltage is held constant through one electrodes and 
current is measured with the other electrode 

• Current clamp 

• Current is held constant and the corresponding membrane 
voltage of the cell is measured 

• Intracellular sharp electrode recording 

• Measurement of action potentials 

• Bridge balance for the pipette resistance 

• Discontinuous clamp 

• Amplifier divides its time between passing current and 
recording voltage 

• Ion-selective electrodes and electrochemistry 

• Measurement of small changes in ion, neurotransmitter 
and hormone concentrations in tissues and cells 

MolDev Axon CEP Products 
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The position of Molecular Devices  

• Market leader 
• Axon brand 

• over 25 years 
• High quality 

• ultra low noise amplifiers 

• High speed, low noise 
digitizers 

• Reliable 

• Lasting in a good condition 
for many years 

• Technical support 

• Professional assistance 
 

• Large install base (17,000) 
• Academic research labs  

• Pharmaceutical/biotechnology drug 
discovery labs 

• >10K amplifiers sold 

• >10K digitizers sold 

• >10K copies of pCLAMP 
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Customer support activities 

• Scientific conferences 

• Society for Neuroscience 

• Biophysical Society 

• FENS 
 

• Online webinars 

• Getting the Most Out of 
pCLAMP series 

 

• pCLAMP Workshops at 
university 

• Duke University 
 

• University loaner 
program/Support training 
courses 

• Cold Spring Harbor marine 
biology lab 

• Woods Hole marine biology lab 

• Australian Course in Advanced 
Neuroscience (ACAN) 

• Patch clamp workshop in 
Singapore 

• More… 
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A Walkthrough of Protocol Editor in 
Clampex 
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Golden Tips that help 

• Study manual 

• Study manual again 

• Ask someone who uses pCLAMP 

• Clampex tutorial 

• Online HELP 

• Knowledge base 

• Webinar tutorials 

• Technical Support 
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Agenda 

• Acquisition Mode  

• Inputs 

• Outputs 

• Trigger 

• Statistics 

• Comments 

• Math 

• Waveform 

• Stimulus 
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Feature Highlights 

• Acquisition modes 

• Scope trigger 

• Holding level overrides 

• Digital OUT holding pattern 

• Stimulus file 

• Digital bit pattern 

• Pre-sweep train 

• P/N leak subtraction 

• User list 

• Membrane test between sweeps 
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Telegraphs 

• Clampex can receive and incorporate arrange 
of “telegraphed” amplifier settings as the 
variable gain, lowpass filter, whole-cell 
capacitance compensation. 
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Telegraph setting in AxoPatchTM 200B 
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Telegraph setting in AxoPatchTM  200B 
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Telegraph setting in MultiClampTM  700B 



©2012 For research use only. Not for use in diagnostic procedures. Trademarks mentioned herein are property of Molecular Devices, LLC or their respective owners. 

1. To define signals for each digitizer channel 
2. To set units and scale factors 

Voltage Clamp 

Lab Bench setting in AxoPatchTM  200B 
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1. To define signals for each digitizer channel 
2. To set units and scale factors 

Current Clamp 

Lab Bench setting in AxoPatchTM  200B 
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Lab Bench setting is telegraphed in 
MultiClampTM  700B 
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Protocol Editor 

Protocol Editor: 
is a the “central” for protocol writing. 
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Acquisition Mode? 

What? 

How fast? 

How long? 

Signals 

Sampling rate 

Sweep duration 
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Mode/Rate 

• Passive Acquisition 

• Gap-free 

• Fixed-length 

• Variable-length 

• High-speed oscilloscope 

 

 

• Stimulus Acquisition  

• Episodic stimulation 
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Gap-free Mode 

• Data are acquired continuously 

• No gaps in data file 

• single-channel or minis recordings 
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Fixed-length Events Mode 

• Constant data segment above the threshold 
and pre-trigger portion are recorded 

• Action-potential spikes or other constant-
width events recordings 
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Fixed-length Event Mode 

Signal 

Threshold 

Pre-trigger length 
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Variable-Length Events Mode 

• Data above the threshold, and for pre- and 
post-trigger periods are recorded.  

• Variable recorded segment 

• “Bursting" data recording 
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Variable-Length Events Mode 
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High-Speed Oscilloscope Mode 

• Like an oscilloscope 
• Data above the threshold, and for pre- and 
post-trigger periods are recorded. 
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Passive acquisition modes 

Check this option to acquire data until the disk is full, or until 

acquisition is stopped manually  

the duration of the data acquisition. in megabytes, 

and in hours, minutes and seconds   

Specify the sampling rate of the 

analog-to-digital conversion  

Enable Configure / Automatic Analysis in Clampfit to 

have new files automatically open in Clampfit. 
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High-speed Oscilloscope Mode 

Check this option to save the raw sweeps and 

average sweep 
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Episodic Stimulation Mode 

• Provide a command waveform and record 
responses, in fixed-length sweeps  

 

• Analog waveform, holding level and/or digital 
pulses are outputs  

 

• Special features include pre-sweep trains, online 
leak current subtraction, online event detection 
and statistics, and an on-line derived-math 
channel.  
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Episodic Stimulation Mode 

Recorded 

Current 

Command 

Voltage 
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Episodic Stimulation Mode 
Specify a delay in 

seconds before the trial 

begins. 
Specify how many runs to execute in the trial, up to 

10,000.  Runs are always averaged, with just the 

average run being saved to the data file.  

Set the number of sweeps in each run, 

up to 10,000. 

Enter the sweep duration in seconds, The 

maximum number of samples is 1,032,258 

per sweep per channel.   
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Episodic Stimulation Mode---Holding 
Periods 

Two "holding" periods at the start and end 

of each sweep, each 1/64th of the total 

sweep duration.  
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Episodic Stimulation Mode 

1. Specify the time (in seconds) from the 

start of one sweep to the start of the next. 

2. The time entered must be greater than 

the time it takes to complete a sweep. 

This includes the time for P/N Leak 

Subtraction and Pre-sweep Trains. 

1 st sweep 2 nd sweep 

Start-to-Start Interval 

mk:@MSITStore:C:/Program Files/Molecular Devices/pCLAMP10.2/Clampex.chm::/Edit_Protocol__Stim_01_tabs.htm
mk:@MSITStore:C:/Program Files/Molecular Devices/pCLAMP10.2/Clampex.chm::/Edit_Protocol__Stim_01_tabs.htm
mk:@MSITStore:C:/Program Files/Molecular Devices/pCLAMP10.2/Clampex.chm::/Edit_Protocol__Stim_01_tabs.htm
mk:@MSITStore:C:/Program Files/Molecular Devices/pCLAMP10.2/Clampex.chm::/Edit_Protocol__Stim_01_tabs.htm
mk:@MSITStore:C:/Program Files/Molecular Devices/pCLAMP10.2/Clampex.chm::/Edit_Protocol__Stim_01_tabs.htm
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Inputs 



©2012 For research use only. Not for use in diagnostic procedures. Trademarks mentioned herein are property of Molecular Devices, LLC or their respective owners. 

Q & A 

• Q: Why the selected input name in the Lab 
Bench does not show up in the scope 
window? 

 

• A: You need to select the input name in the 
Input tab of the Edit Protocol. 
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Outputs 

Voltage-clamp 

Current-clamp 

Check to specify one digital output 

channel to go high (and stay high) 

during the entire length of a trial  
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Digital Out Holding Pattern 
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Holding Level Overrides 
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Holding Level Overrides 
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Holding Level Overrides 
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Q & A 

• Q: How do I change the command voltage for 
more than 200 mV 

 

 

 

• A: You need to change the scale factor and 
external sensitivity of analog output signal on 
the Lab Bench 
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Scale Factor/ External Command 
Sensitivity 
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Scale factor/Output 
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Q & A 

• Q: I want to perform current clamp experiment. How do I 
change the command voltage to current 
 
 
 
 
 

• A: You need to change the signal unit and scale factor on the 
Lab Bench. 
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Trigger 
• Immediate 

• As soon as you choose Acquire / Record or 
Acquire / View Only, or press the equivalent 
toolbar button, the trial starts.  

• Digitizer START Input 

• To trigger the start of a trial from an 
external device.  

• Space Bar 

• Start the trial with a toolbar press or mouse 
click.  

• Line Frequency 

• Only for series 132x Axon digitizers  

• synchronized with the mains line frequency 
(typically 50 or 60 Hz).  

• Software Message 

• To trigger the trial from the other program  

mk:@MSITStore:C:/Program Files/Molecular Devices/pCLAMP10.2/Clampex.chm::/Record.htm
mk:@MSITStore:C:/Program Files/Molecular Devices/pCLAMP10.2/Clampex.chm::/View_Only.htm
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Trigger 

• Internal Timer 
• Determines acquisition according to the 

length of the sweeps and Start-to-Start 
Intervals and any Conditioning Trains or 
P/N Leak Subtraction 

• First Acquired Signal 
• Once a threshold in the signal from the 

first Analog IN Channel is crossed.  

• Digitizer START Input 
• To trigger the start of a trial from an 

external device. 

• Space Bar 
• Acquisition is started by pressing the 

space bar  

• Line Frequency 
• Only for series 132x Axon digitizers  

• Synchronized with the mains line 
frequency (typically 50 or 60 Hz). 
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Scope Trigger 

• A 5 V TTL trigger signal from a digitizer 
output when the signal reaches the 
threshold.  

 

• The rear panel TRIGGER OUTPUT BNC (Digidata 
1322)   

• The front panel SCOPE BNC (Digidata 1440) 
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DD1440A Stimulator 

Scope trigger 

scope Trigger 
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Hysteresis 

• To prevent signal noise activating 
false triggers, you can adjust the 
hysteresis settings to reduce 
trigger sensitivity. 

• Time hysteresis 
• This field adjusts the amount of time that the 

signal has to be under the threshold level (as 
determined by the Level Hysteresis setting 
below) to re-arm the trigger.  

• Level hysteresis 
• This field adjusts the distance that the signal 

must be under the threshold in order to re-arm 
the trigger (subject to the Time Hysteresis 
setting above).  
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Time hysteresis 

• Adjust the time hysteresis to reduce 
sensitivity to avoid the false triggers. 

reject 

signal 

noise 
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Threshold-Based Statistics 

• Percentage above threshold 
• Display the percentage of time that the signal is above the 

threshold value 

• Event frequency (Hz) 
• Display the frequency of threshold-crossing 

• Mean open (ms) 
• Display the average time that the signal is above threshold. 

• Mean closed (ms) 
• Display the average time that the signal is below threshold. 
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Threshold-Based Statistics 
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Statistics 
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Statistics 
B B 1 1 
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80% 

50% 

20% 

B B 1 1 
Statistics 
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Rise Decay 

Rise 

Decay 
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Q & A 

• How many search regions can be applied during data 
acquisition? 

 

• How? 
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Comments 

• The comments can be written automatically 
to every data file  

• The comments are stored with data file 
information in the file header, viewed from 
File / Properties, and can also be displayed in 
the Data File Index. 

mk:@MSITStore:C:/Program Files/Molecular Devices/pCLAMP10.2/Clampex.chm::/Properties.htm
mk:@MSITStore:C:/Program Files/Molecular Devices/pCLAMP10.2/Clampex.chm::/Data_File_Index_Shortcuts.htm
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Comments 
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Math 

• Allows arithmetic calculation between two 
analog input signals  

• Calculate on-line ratios, products, sums and 
differences. 
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Math 
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Waveform 

100 ms 

0 mV 

112 mV 
92 mV 

72 mV 
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Epochs 



©2012 For research use only. Not for use in diagnostic procedures. Trademarks mentioned herein are property of Molecular Devices, LLC or their respective owners. 

Default waveforms 

Step: 

Ramp: 

Pulse  

train: 
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Default waveforms 

Biphasic 

train: 

Triangle 

train: 

Cosine 

train: 
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Stimulus File 
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Stimulus File 
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Stimulus File 
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Stimulus File 
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Stimulus File 
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Action Potential Waveform 
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Digital Outputs 
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Digital Bit Pattern 

Digital bit pattern (#3-0): 0101 

DO#3 DO#2 DO#1 DO#0 

1 High, single  TTL (5V) 

0 Low, No single TTL (5V) 

an asterisk,* A pulse train of TTL (5V) 
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Digital Bit Pattern---Single Pulse 

Digital bit pattern (#3-0): 0101 

DO#0: 

 

DO#1: 

 

DO#2: 

 

DO#3: 
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Digital Bit Pattern---Train Pulse 
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Digital Bit Pattern---Train Pulse 
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Digital Bit Pattern 
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Intersweep Holding Level 
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Intersweep Holding Level---Use last 
epoch 
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Intersweep Holding Level---Use 
Holding 
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Alternative Waveform 

CMD 0 

CMD 1 
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Alternative Waveform 

CMD 0 

CMD 1 
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Alternative Waveform 
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Alternative Digital Outputs 

DO# 0 

DO# 1 
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Alternative Digital Outputs 
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Pre-sweep Train 

• A pre-sweep train consists of repeated 
square waveform pulses 

• Conditioning trains  

• No acquisition occurs  
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Pre-sweep Train 
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P/N Leak Subtraction 

• Leak subtraction corrects for the passive responses by 
applying test subsweeps before or after the main 
stimulus waveform 

• The technique is called P/N subtraction, in which N 
subsweeps each 1/Nth of the amplitude of the main 
stimulus waveform are applied. 

• Example: Number of subsweep (N)=4, the stimulus 
waveform (P)= 80 mV, the pulse of each 
subsweep=80/4=20 mV  
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P/N Leak Subtraction 
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• Customizing output features 

• Analog 

• digital 

• Overrides the generalized settings made elsewhere 
in the Protocol Editor. 

User List 
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Sweep 1: -50 mV 
Sweep 2:  65 mV 
Sweep 3: -20 mV 
Sweep 4: 100 mV 
Sweep 5:  29 mV 

You can set the arbitrary delta values 
for the waveform holding levels. 

User List 

User List---Holding Level 
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Sweep 1: 22 ms 
Sweep 2: 44 ms 
Sweep 3: 100 ms 
Sweep 4:  75 ms 

You can set the arbitrary delta values 
for the waveform sweep durations. 

User List---Epoch Duration 
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• Epoch A–J level 

• Epoch A–J duration 

• Epoch A–J digital pattern 

• Epoch A–J train period 

• Epoch A–J train pulse width 

• Time between sweep starts (s) 

• Inactive analog OUT holding level 

• Digital intersweep holding level 

• Number of P/N subsweeps 

 

• Number of pulses in pre-sweep 
train  

• Pre-sweep train baseline duration 
(ms) 

• Pre-sweep train baseline level 
• Pre-sweep train step duration (ms)  
• Pre-sweep train step level 
• Post-train duration (pre-sweep 

train) (ms)  
• Post-train level (pre-sweep train) 

User List---Change in Parameters 
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• The list of values for the A Epoch level might be: 

• -50, 65, -20, 100, 29 

 

• The list of values for the A Epoch duration might be: 

• 22, 44, 100, 75 

 

 

Lists of parameter values 
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1st sweep 2nd sweep 3th sweep 

1 s 1 s 1 s 

1 s 1 s 

= Membrane test 

100 ms 100 ms 100 ms 100 ms 

Membrane Test Between Sweeps 
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pCLAMPTM  10 data acquisition software: Key features review 
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Key features of Clampex 10 

• Online Statistics 

• Sequencing keys 

• User list 

• Membrane test between sweep 

• Protocol editor 

• LTP assistant 

• Stimulus file 

• Triggering external devices 
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Online Statistics 

• Measure various parameters of evoked events such 
as peaks, slopes, areas, and rise time 

• Available in episodic and oscilloscope modes 

• Up to 8 search regions  
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* 

* 

Outward signal Inward signal 

Example: 

Excitatory postsynaptic potential (EPSP) 

Example: 

Excitatory postsynaptic current (EPSC) 

Population spikes 

Field EPSP 

Baseline 

Baseline 
Peak 

Peak 

Slope 

Slope 
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Peak 

Rise slope EPSC 
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Click “Help” for 

feature description 
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Sequencing Keys 

• Sequencing keys command allows you associate events, or a 
sequence of event, with a keystroke. 
• Set various digital outputs 

• Change the holding levels 

• Insert a comment tag 

• Start a Membrane Test 

• Load or run a protocol 

• Display a prompt 

 

• Use sequencing keys to link one event to another, and run an 
experiment in an “automated” fashion. 
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Membrane test 

Drug A/ 
Digital Output “0” ON 

Protocol A  

START 

Protocol B  

Prompt/ 
Wait for 5 s 

Protocol C  

Membrane test 

END 

An experimental protocol 
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Sequencing Keys 

• The key strokes and tool button identifiers used for sequencing keys 
are:  

• <Alt + 0> through <Alt + 9> (i.e. hold down the Alt key and press the 
relevant numeral) 

• <Alt + Shift + 0> through <Alt + Shift + 9> 

• <Ctrl + 0> through <Ctrl + 9> 

• <Ctrl + Alt + 0> through <Ctrl + Alt + 9> 

• <Ctrl + Shift + 0> through <Ctrl + Shift + 9> 

• 50 sequencing keys can be triggered in one time. 
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Membrane test 

Protocol A  

Drug A/ 
Digital Output “0” ON 

START 

Protocol B  

Prompt/ 
Wait for 5 s 

Protocol C  

Membrane test 

END 

Ctrl 1 

Ctrl 2 

Ctrl 3 

Ctrl 4 

Ctrl 5 

Ctrl 6 

Ctrl 7 

Set sequencing keys 
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Sequencing Keys 

• Only the key for the first element needs to be 
triggered to start off the entire sequence.  
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START 

END 

Membrane test Ctrl 1 

Protocol A  Ctrl 2 

Drug A/ 
Digital Output “0” ON Ctrl 3 

Protocol B Ctrl 4 

Prompt/ 
Wait for 5 s 

Ctrl 5 

Protocol C  Ctrl 6 

Membrane test Ctrl 7 

Ctrl 1 

Run a protocol in an automated fashion 
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User List 

• Provide a way of customizing one of a range of 
analog and digital output features. 

• It overrides the generalized settings made 
elsewhere in the Protocol Editor. 
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User List 

• With User List you can select one of a range of 
parameters offered, to configure on a sweep-by-
sweep basis.   

• This function allows you to set specific values for 
each sweep in a run.  You can also set a sequence 
of values and have this repeat. 
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Sweep 1: -50 mV 
Sweep 2:  65 mV 
Sweep 3: -20 mV 
Sweep 4: 100 mV 
Sweep 5:  29 mV 

You can set the arbitrary delta values 
for the waveform holding levels. 

Change in Epoch holding levels 
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Sweep 1: -20 mV 
Sweep 2:  100 mV 
Repeat… 

Change in Epoch holding levels 
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Change in Epoch durations 

Sweep 1: 22 ms 
Sweep 2: 44 ms 
Sweep 3: 100 ms 
Sweep 4:  75 ms 

You can set the arbitrary delta values 
for the waveform sweep durations. 



©2012 For research use only. Not for use in diagnostic procedures. Trademarks mentioned herein are property of Molecular Devices, LLC or their respective owners. 

Sweep 1: 22 ms 
Sweep 2: 75 ms 
Repeat… 

Change in Epoch durations 
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• Epoch A–J level 
• Epoch A–J duration 
• Epoch A–J digital pattern 
• Epoch A–J train period 
• Epoch A–J train pulse width 
• Time between sweep starts (s) 
• Inactive analog OUT holding level 
• Digital intersweep holding level 
• Number of P/N subsweeps 
 

• Number of pulses in pre-sweep train  
• Pre-sweep train baseline duration (ms) 
• Pre-sweep train baseline level 
• Pre-sweep train step duration (ms)  
• Pre-sweep train step level 
• Post-train duration (pre-sweep train) 

(ms)  
• Post-train level (pre-sweep train) 

Parameter to Change 
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Examples: List of Parameter values 

• The list of values for the A Epoch level might be: 

• -50, 65, -20, 100, 29 

 

• The list of values for the A Epoch duration might be: 

• 22, 44, 100, 75 

 

 



©2012 For research use only. Not for use in diagnostic procedures. Trademarks mentioned herein are property of Molecular Devices, LLC or their respective owners. 

Change in Epoch holding levels 
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Change in Epoch durations 
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Membrane Test Between Sweeps 
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Membrane Test 

• Access resistance, Ra 

• Membrane resistance, Rm 

• Membrane capacitance, Cm 

• Time constant, Tau 

• Holding current, Hold 



©2012 For research use only. Not for use in diagnostic procedures. Trademarks mentioned herein are property of Molecular Devices, LLC or their respective owners. 



©2012 For research use only. Not for use in diagnostic procedures. Trademarks mentioned herein are property of Molecular Devices, LLC or their respective owners. 

1st sweep 2nd sweep 3th sweep 

1 s 1 s 1 s 

1 s 1 s 

= Membrane test 

100 ms 100 ms 100 ms 100 ms 
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.sta 
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Online statistic measurement 

Membrane Test Between 
Sweeps 

Summary 



©2012 For research use only. Not for use in diagnostic procedures. Trademarks mentioned herein are property of Molecular Devices, LLC or their respective owners. 

Stimulus File 

• Stimulus Files are used when the Waveform Editor 
cannot create the desired waveform. 



©2012 For research use only. Not for use in diagnostic procedures. Trademarks mentioned herein are property of Molecular Devices, LLC or their respective owners. 



©2012 For research use only. Not for use in diagnostic procedures. Trademarks mentioned herein are property of Molecular Devices, LLC or their respective owners. 

Default waveforms 

Step: 

Ramp: 

Pulse  

train: 
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Default waveforms 

Biphasic 

train: 

Triangle 

train: 

Cosine 

train: 
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How to create an action potential 
waveform? 
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Advanced Tips for Protocol Writing in the Clampex Data 
Acquisition Module 
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Whole cell and Extracellular Recordings 

Postsynaptic 

cell 

Presynaptic 

cell 

Presynaptic 
Stimulation 

Postsynaptic 
current 

Electrode 1: 
Intracellular 

Presynaptic 
Stimulation 

Postsynaptic 
fEPSPs 

Electrode 2: 
Extracellular 
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Pair-pulse stimulation 

50 ms 

Application: Synaptic plasticity, release probability 
in brain slice preparation  
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Pair-pulse Stimulation: Presynaptic afferents 

Presynaptic 
Stimulation 

Postsynaptic 
current 

Electrode 1: 
Intracellular 

Presynaptic 
Stimulation 

Postsynaptic 
fEPSPs 

Electrode 2: 
Extracellular 
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Pair-pulse stimulation 

50 ms 
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Train stimuli 

1 sec 

10 Hz 

Application: Synaptic plasticity, LTD 
in brain slice preparation 
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Train stimuli-10 pulses 

10 Pulses 
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Train stimuli-50 pulses 

50 Pulses 
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Summary 

• Telegraphing/Lab Bench settings 

• Writing protocols for 

• Pair-pulse stimulation/Digital Output 

• Train stimulation 
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Application: Synaptic plasticity, LTP/LTD 
in brain slice preparation  

100 Hz 

1sec 10 sec 

-80 mV 

0 mV Postsynaptic holding 
potential 

Presynaptic stimulation 

Tetanus Stimulation protocol 
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Presynaptic stimulation 

1sec 10 sec 

-80 mV 

0 mV Postsynaptic holding 
potential 

Tetanus Stimulation and Postsynaptic 
Depolarization 

LTP: 

Pre-stim Post-stim 

LTD: 

Pre-stim Post-stim 

100 Hz 
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Tetanus Stimulation and Postsynaptic 
Depolarization  
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Spike timing protocol 

Presynaptic 
stimulation 

Postsynaptic 
stimulation 10 ms 

Application: Synaptic plasticity, LTP/LTD 
in brain slice preparation and culture cell 

Current 
Clamp 

Current 
Clamp 
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Postsynaptic 
cell 

Current 
Clamp 

Voltage 
Clamp 

Dual Whole-cell Patch-clamp Recordings 
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Presynaptic cell 
(Current-clamp) 

Postsynaptic cell 
(Voltage-clamp) 

Presynaptic 
Stimulation 

Postsynaptic 
current 

Dual Whole-cell Patch-clamp Recordings 
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Spike timing protocol: EPSP precedes Action 
Potential 

10 ms later 

Dendrite 

Postsynaptic cell 
(under Current Clamp) 

All about the “Timing”: 
The change of synaptic efficacy of the 
postsynaptic cell depends upon 
1. the timing of the incoming inputs 
2. the excitability of the postsynaptic cell  
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Current 
Clamp 

Current 
Clamp 

Presynaptic 
stimulation 

Postsynaptic 
stimulation 10 ms 

Spike timing protocol: EPSP precedes Action 
Potential 
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10 ms 

Spike timing protocol: EPSP precedes Action 
Potential 
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Spike timing protocol: Action Potential 
precedes EPSP 

10 ms later 

Dendrite 

Postsynaptic cell 
(under Current Clamp) 



©2012 For research use only. Not for use in diagnostic procedures. Trademarks mentioned herein are property of Molecular Devices, LLC or their respective owners. 

Current 
Clamp 

Current 
Clamp 

Presynaptic 
stimulation 

Postsynaptic 
stimulation 10 ms 

Spike timing protocol: Action Potential 
precedes EPSP 
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Spike timing protocol: Action Potential 
precedes EPSP 

10 ms 
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Action Potential Analysis in Clampfit 
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Frequent Ask Questions in Action Potential Analysis 

• How can I measure the frequency of action potentials? 

• The baseline of my recording is drifting. It is hard to analyze the 
spikes. 

• How do I sort the spikes? 

• My recording is too noisy. It is hard to retrieve the spikes from the 
noises? 

• When I do the event search, how can I avoid the large spike of 
stimulation artifacts? 

• How do I perform a phase plot of dV/dt vs V in Clampfit? 

• How do I calculate the cardiac action potential duration at 90% 
repolarization (APD90%)? 



©2012 For research use only. Not for use in diagnostic procedures. Trademarks mentioned herein are property of Molecular Devices, LLC or their respective owners. 

What we learn today 

• Baseline adjustment 

• Event Search 

• Event sorting 

• Noise/Event rejection 

• Spike alignment 

• Combine trace 

• Phase plot 

• Action potential analysis 
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Features in Clampfit 

• Baseline adjustment 

• Manual baseline adjustment 

• Search event 

• Event Detection/Threshold Search 

• Event sorting 

• Event Detection/Threshold Search 

• Spike alignment 

• Time shift 

• Phase plot/Combine trace 

• Arithmetic 

• Action potential analysis 

• Statistics 
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Baseline adjustment 

Drifting baseline 

Stable baseline 
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Event Search 

Trigger level 

Baseline level 

If an event crosses the trigger level, the event will be accepted. 
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Event Sorting 

• Extract events from a gap-free file and transform them into 
sweeps. 

Gap-free files Sweep files 
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Noise/Event Rejection 

• Event rejection based on amplitude 

• Noise rejection based on short duration 

• Event rejection based on event length 
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Noise/Event Rejection based on amplitude 

Reject 

Rejection level 

Trigger level 

Baseline level 

If an event crosses the rejection level, the event will be rejected. 
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Noise/Event Rejection based on too short duration 

Noise duration in ms can be set to reject noise spikes. 

Reject 

Accept 
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Noise/Event Rejection based on event duration 

Reject 

You can select Min allowed duration to eliminate short events. 

You can select Max allowed duration to discard events that are too long. 

Trigger level 

Baseline level 
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Peak Alignment 
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Combine traces  

6/20/2013 Pg. 171 

+ = 

Trace in File A Trace in File B Trace combined 
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Phase Plot 

• Plot dV/dt versus V 
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Cardiac Action Potential Analysis 

• Resting membrane potential 
(RMP)  

• Action potential Amplitude 
(APA) 

• Action Potential Duration 
(APD) 

• Max Slope of depolarization 
(Vmax) 

RMP 

APA 

Vmax 
APD50% 

APD90% 
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Event Detection/Threshold Search 
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Set category 

• Each category represents a 
unique search criterion. There 
are up to 8 different 
categories 

• The positive- and negative-
going describe the location of 
peak relative to baseline. 

• Action potential is a positive-
going event 
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Bring markers 

• Bring markers 

• Baseline marker 

• Trigger marker 

Trigger marker 

Baseline marker 
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Re-arm 
Start of 

an event 

End of 

the event 

End of 

the event 

Trigger 

Baseline 

Trigger 

Baseline 

Re-arm 
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Event Rejection 

Rejection level 

Trigger level 

Baseline level 

R 
R R 
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Noise Rejection 

6/20/2013 Pg. 179 

Event Start and End 

with 5 ms Noise rejection 

Event Start and End 

without Noise rejection 
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Pre-trigger and Post-trigger 

5 ms 20 ms 

Trigger 

Baseline 

Trigger 

Baseline 
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Event Rejection 

Trigger 

Baseline 

Trigger 

Baseline 

R R R 

R R R 
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Accept, Reject, Suppress, Accept Tag  

A A R R S S AT AT AT 
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Event States 

A A R R S S AT AT AT 

Event Detection/Show Suppressed Events 
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Phase Plot 

Select the trace 
Transfer trace 

Plot dV/dt vs V 
Column 

Arithmetic 

cC=diff(cB) 
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Summary 

• Baseline adjustment 

• Event Search 

• Event sorting 

• Noise/Event rejection 

• Spike alignment 

• Combine trace 

• Phase plot 

• Action potential analysis 
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Analysis of Synaptic Events with the 
Clampfit Data Analysis Module 
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Agenda 

• Are there differences in the amplitude distribution? 

• Post-synaptic mechanism 

• Are there differences in the frequency? 

• Pre-synaptic mechanism 

13.51312.5

Time (s)

IN
 0

(p
A

)

-200

-150

-100

-50

0

50• Postsynaptic miniature currents (EPSCs) 

• Pre-drug 

• Post-drug 

Minis02_Predr

ug.abf 

3534.534

Time (s)

IN
 0

(p
A

)
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-150
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-50

0

Minis03_Postdrug.
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Strategy 

Create a template from 
one of the data files 

Perform a template search on a data 
segment before addition of compound… 

…and on a dataset after 
addition of compound 
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Strategy 

Create cumulative histograms of 
the peak amplitudes… 

…and the inter-event intervals. 
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Strategy 

Perform a statistical 
analysis to determine 
whether there are 
differences between 
the two datasets. 

p = 15% 

K-S =  7% 

p < 10-6 

K-S =  43% 
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Clampfit Features Discussed 

• Event Detection > Create Template 

• Event Detection > Template Search 

• Move Cursors efficiently 

• View > Zoom > Between Cursors 

• Analyze > Arithmetic 

• Format > Column > Rename 

• Format > Rename Sheet 

• Analyze > Histogram 

• Efficiently creating a graph using X-Y pairs 

• Editing a graph 

• Analyze > Kolmogorov-Smirnov Test 

• Analyze > Basic Statistics 
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Creating a Template 

Zoom in to 
the first 

few 
seconds 

[Shift] + [Click] 

brings the cursors 
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Creating a Template 

Continue adding events 
to generate a 

smooth template 

Enclose an event with 
cursors 1 and 2 

When done, save 
the template 
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Delimit the Analysis Region 

Full-scale 
the 
time axis, 

…“Home” to the start 
of the trace 

and send cursor 1… 

unlock 
cursors 1 
and 2, 
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Delimit the Analysis Region 

Double-
click on 
Cursor 2, 

send it to 
30 s, 

…and zoom the 
region we are 

going to analyze 
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Template Search 

Start Template Search 
and 

load the newly created 
template 
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Template Search 

Define the measurement 
region. 

Set taus and analysis 
region. 
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Template Search 
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Defining “Sanity-check” Graphs 

This graph suggests that 

there are not two (or more) 

classes of events with clearly 

distinct amplitude. 

This graph Indicates the 

absence of an overall trend 

(run-up or run-down of 

amplitude or frequency). 
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Copying the Pre-compound Results to a 
New Sheet 
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Computing the Absolute Peak Amplitude 

Double-click on the 
column header to 

rename 

cBH = cH * (-1) 
yields the absolute 

peak amplitude 
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Creating a Cumulative Peak Histogram 
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Repeat the Template Search After 
Compound Addition 

Starting Template Search with a 
new file erases all results on 
the Events sheet (but not 
Sheet 19 ) 
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Post-compound Results 

The post-compound data file 
after completed analysis with 

“sanity check graphs”. 
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Repeat Post-processing Steps 

Copy the results to Sheet 20, 
rename the sheet and column H 

Compute the 
absolute peak 

Rename the other 
relevant columns 

Create a post-compound 
cumulative histogram 
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Normalizing the Histogram Values 

Normalize the Bin Count columns 
on the Histogram sheet 

 

cE = norm(cB) 

cF = norm(cD) 

Rename the two new columns 
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Creating a Combined, Normalized 
Cumulative Histogram 

Make the first “Bin 
Center” column an X 
column 

Make the “Norm Pre 
Peak” column a Y 
column 

Define the two 
columns as an X-
Y pair 
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Creating a Combined, Normalized 
Cumulative Histogram 

Repeat for the second “Bin 
Center” column and “Norm 
Post Peak” 

Create a new graph 

and double-click on it 
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Creating a Combined, Normalized 
Cumulative Histogram 

Modify Graph titles, axis 
titles and plots for an 
appearance as shown 
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Kolmogorov-Smirnov Test 

Copy both “Abs Peak” 
columns 

to Sheet 18 

Apply the Kolmogorov-
Smirnov Test 
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Kolmogorov-Smirnov Test Results 

15% probability that the tested 

samples are from the same 

universe => no statistically 

significant difference 

The Kolmogorov-Smirnov Statistic 

value corresponds to the greatest 

Y difference between the 

histograms: 
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Creating Histograms for Inter-event 
Intervals 

Create Histogram 
(x2) 

cK = norm(cH) 

cL = norm(cJ) 
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Creating Histograms for Inter-event 
Intervals 

Define X-Y pairs 
(x2) 

Create a graph 

Modify the graph 



©2012 For research use only. Not for use in diagnostic procedures. Trademarks mentioned herein are property of Molecular Devices, LLC or their respective owners. 

Kolmogorov-Smirnov Test for Inter-
event Intervals 

Copy Pre and Post 
IEI columns to 

Sheet 18 

Be sure to Append, 
not Replace the 

results 
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Kolmogorov-Smirnov Test Results 

p<10-6 => highly statistically 

significant difference between the 

IEIs recorded in the two conditions 

The Kolmogorov-Smirnov Statistic 

value again corresponds to the 

greatest Y difference between the 

histograms: 
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Retain the Kolmogorov-Smirnov Results 

Copy the results of 
the two K-S tests 

to Sheet 17 
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Basic Statistics for Peaks and Inter-
event Intervals 
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Summary 

• Are there differences in 
the amplitude 
distribution? 

• No. 
• Post-synaptic 

mechanisms are 
unaffected. 

 

 
 

• Are there differences in 
the frequency? 

• Yes. 
• Pre-synaptic 

mechanisms are 
upregulated. 

p = 15% 

K-S =  7% 

p < 10-6 

K-S =  43% 



©2012 For research use only. Not for use in diagnostic procedures. Trademarks mentioned herein are property of Molecular Devices, LLC or their respective owners. 

Clampfit Features Discussed 

• Event Detection > Create Template 

• Event Detection > Template Search 

• Move Cursors efficiently 

• View > Zoom > Between Cursors 

• Analyze > Arithmetic 

• Format > Column > Rename 

• Format > Rename Sheet 

• Analyze > Histogram 

• Efficiently creating a graph using X-Y pairs 

• Editing a graph 

• Analyze > Kolmogorov-Smirnov Test 

• Analyze > Basic Statistics 
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End 

Thank You 
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